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OVERVIEW ORGANIZATION OF THIS DOCUMENT

The STS-1400 Operator Manual is organized according to the following sections:

Section 1.0 Describes general information regarding the nature of the document and its intended audi-

ence. This section also describes the equipment features and limitations of the STS-1400 radar assembly.

Section 2.0 Contains an overview of the STS-1400 radar system.

Section 3.0 Describes various components of the STS-1400 radar system.

Section 4.0 Describes the operation of the STS-1400 radar system software components.

Section 5.0 Describes the troubleshooting process of the STS-1400 radar system.

Definitions and Acronyms

AXML Amphitech eXtensible Markup Language

BIT Built-in Test

CE Refers to CE marking, a conformity mark in Europe

CFAR Constant False Alarm Rate

FCC Federal Communications Commission (usually refers to the US agency)

GPS Global Positioning System

GUI Graphical User Interface

IP Internet Protocol

MBPS MegaBits Per Second

MMW Millimeter Wave

PPI Plan Position Indicator

PPS Pulse Per Second

PSR Perimeter Surveillance Radar

RCS Radar Cross Section

RF Radio Frequency

VDC Volts of Direct Current

XML Extensible Markup Language
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1 INTRODUCTION

This manual describes the STS-1400 Perimeter Surveillance Radar’s (PSR) operation. The Operator Man-

ual is intended for an audience of technically qualified personnel.

For installation and configuration of the STS-1400 Radar System, or for more advanced functions, please 

refer to the STS-1400 Installation Manual.

NOTE:   Please note that product name STS-1400 is used throughout this manual for ease of reading. The 

given information is also valid for products STS-700 and STS-2800 unless otherwise noted.

1.1 EQUIPMENT FEATURES

The mid-range radar product line provides detection capability for moving objects on the ground out to 

an instrumented range of 700, 1400 or 2800 meters (for STS-700, STS-1400 and STS-2800 respectively) 

over an area of up to 360° around the radar and presents detection data to the operator via a graphical 

user interface (GUI). The data may also be transmitted via XML (eXtensible Markup Language) to a third-

party software application responsible for implementing security policies. 

STS-700, STS-1400 and STS-2800 Specifications for Hardware Version 3.0

Weight 22 Lbs (10 Kg)

Cooling No forced cooling required

Operating Temperature Range -30º C to +60º C

Operating Altitude Range Up to 15 000 feet / 4572m

Power Input 20 - 32 VDC (Nominal 28 VDC ), less than 45 W 

Frequency Band Ka

Detection Range Minimum 5 m., Maximum of 700m, 1400m or 2800m extended 
range (optional)

In 2800m mode, human detection performance is reduced 
(depending on environmental conditions)

Sensitivity Detection of a 0.5 square meter (RCS) target located at a range 
of 1000m (in 700m and 1400m range modes)

Warm up Time Ready to operate approximately 30 seconds after power-up

Revisit Rate 55 scans / minute

Table 1 - STS-700, STS-1400 and STS-2800  Radar Assembly Specifications
Operator Manual – STS-1400
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DISCLAIMER: The STS-1400 is designed for operation while in a fixed location and is not intended for 

use on moving platforms. Failing to adhere to this recommendation could compromise the detection 

capability of the unit.

DISCLAIMER: Due to the inherent nature of radar detection, the STS-1400 may present “nuisance” 

alarms triggered by animals, moving tree branches, ocean surf or waves moving within the radar field of 

detection. Strategies to reduce these nuisance alarms are discussed in the Installation Manual.

DISCLAIMER: Due to the inherent nature of radar detection, small and/or very slow moving objects 

may not be detected by the STS-1400.

DISCLAIMER: Under heavy rainfall conditions (>10mm/hr), the STS-1400 performance can be reduced, 

typically for targets furthest away. Under such conditions, the unit may not detect some moving objects 

and it may result in increased nuisance alarms.

Certification

FCC class B, EN 301489, Parts 1 & 3CE:
EN 60215

EN 300019-1-4 (Class 4.1E with -40°C)
EN 300019-1-5 (Class 5.2 including mechanical class 5M3)

Description Minimum Requirements

Dedicated computer for the radar server Intel, Dual-Core 2.80 GHz, 2 GB of RAM,
 2 Ethernet adapters

Operating System Windows XP, Windows 2000 Server

Power Supply
Xantrex XFR 60-20. 28 VDC power supply with a 

capacity of at least 120 Watts continuous

Ethernet Cabling Cat 5e or 6 Ethernet cable

Ethernet Switch 4-port Ethernet switch 10 Mbps or higher

Table 2 - Recommended Equipment

STS-700, STS-1400 and STS-2800 Specifications for Hardware Version 3.0

Table 1 - STS-700, STS-1400 and STS-2800  Radar Assembly Specifications
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2 RADAR OVERVIEW

Critical infrastructures such as airports, harbors, nuclear power plants, pipelines, encampments and 

other sensitive sites require reliable surveillance capabilities to detect intruders. This requirement was 

traditionally met by guards using visual observation. Experience has demonstrated that this solution can 

be of limited effectiveness in conditions of reduced visibility and, as a result, can provide an inadequate 

security response time. Millimeter Wave (MMW) and Perimeter Security Radar (PSR) bring three impor-

tant features to the surveillance solution:

1. Ability to penetrate poor visibility environments

2. Accurate ranging capability in excess of a kilometer

3. Ability to quickly detect moving targets over a 360° field of view

The STS-1400 system provides for timely alerts of moving objects within the monitored area pro-

grammed in the system and increases user’s awareness of potential threats. This is achieved with radar 

technology and sophisticated detection and alarm processing software. 

The STS-1400 operates by transmitting frequency modulated continuous RF radio signals at a given azi-

muth angle, and then computes the frequency differences between the transmitted signal and the sig-

nals from objects/targets that are bounced back to the receiver. The frequency differences are 

converted to target ranges.

This bouncing off effect, or backscatter, from an object depends mainly on factors such as the material 

from which the object is made, its dimension, its shape and the angle at which the signal hits the 

object. This is defined as the Radar Cross Section (RCS).

The RCS is a measure of the target’s ability to reflect radar signals back in the direction of the radar 

receiver. The detection of an object also depends on its distance from the radar. The further away the 

object, the more difficult it is for the radar to detect it.

The STS-1400 Perimeter Surveillance Radar is designed to detect an object with a RCS of 0.5 m2 at 1 km 

(1000 meters). An RCS of 0.5 m2 does not mean that the object is physically 0.5 m2 in cross section; it 

means that its apparent size as observed by the radar is equivalent to a metallic sphere with a projected 

area of 0.5 m2.
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Table 3  shows detection ranges for targets detected in a mildly cluttered environment. The actual 

detection distances obtained depends on a number of factors, such as: radar installation height, tilt 

angle, terrain type, terrain relief, weather, etc.

With accurate positioning in the azimuth, the position of an object relative to the radar can be deter-

mined with high precision. For the STS-1400 radar to provide timely alerts and accurate object location 

in latitude and longitude, latitude/longitude coordinate inputs are required at installation time.

The system is fully adaptive to the environment. Using the data from the processed signal returns and 

with constant false alarm rate (CFAR) algorithms, the radar automatically adjusts for rain, clutter and 

other environmental factors.

Target

Physical 
Dimensions Approximate 

RCS (m2) 

Probable 
Detection 

Ranges 
(700 m)

Probable 
Detection 

Ranges 
(1400 m)

Probable 
Detection 

Range 
(2800 m)

Height 
(m)

Width 
(m)

Crawling person 0.3 0.3 .03 ~ 0.1 5 - 500 m. 5 - 500 m. 5 - 500 m.

Walking person 1.7 0.5 0.3 ~ 1 5 - 700 m. 5 - 1400 m. 5 - 1900 m.

Car 1.5 2.5 5 ~ 100 5 - 700 m. 5 - 1400 m. 5 - 2500 m.

Table 3 - Detection Distance as a Function of Target Type
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3 SYSTEM DESCRIPTION

3.1 HARDWARE COMPONENT DESCRIPTION

The STS-1400 Radar System supports the following components. Some of these components may not be 

used, depending on the specific installation.

1. STS-1400 Radar Assembly

2. Radar Server computer

3. Client computer

4. Breakout box

5. Radar power supply

6. Network infrastructure

7. Cabling

3.1.1 Physical System Overview

Figure 1 shows a typical STS-1400 Radar System, from a hardware components perspective.

Figure 1 -  STS-1400 Radar System Physical Overview
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The STS-1400 Radar Assembly consists of the radar antenna and RF components, a mechanical scanning 

sub-assembly, and a processor sub-assembly. 

The STS-1400 Radar Assembly possesses a hardware revision number that determines some of its func-

tionality. Table 4 provides the hardware revision number according to the radar assembly serial number. 

Unless otherwise specified, this manual will refer to revision 3.0 of the hardware.The STS-1400 Radar 

Assembly possesses a hardware revision number that determines some of its functionality. Table 4 pro-

vides the hardware revision number according to the radar assembly serial number. Unless otherwise 

specified, this manual will refer to revision 3.0 of the hardware.

3.1.2 Radar Server Computer

The Radar Server computer hosts the following applications: Radar Application Manager, Radar Server, 

Radar Terminal, Radar Console (configuration and diagnostics only) and Control Station Interface. 

Figure 2 -  STS-1400 Radar Assembly

Radar Assembly P/N Hardware revision number

921-0011-02-R05.XX 1.0

921-0011-02-R24.XX
921-0011-02-R27.XX

1.5

921-0011-03-R27.XX
921-0011-04-R02.XX

2.0

921-0011-05-R06.XX 3.0

921-0011-R05-R07.XX 4.0

Table 4 - STS-1400 Radar Assembly Hardware Revision Number
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Depending on the installation, the Radar Server computer may also host the client applications and 

function as the Client Computer (see below).

3.1.3 Radar Client Computer

The Client computer hosts the client applications (Radar Console, Radar Terminal, Control Station or an 

XML third-party application). The Radar Console can also be used for remote diagnostics.

3.1.4 Breakout Box

In some installations a breakout box may be installed in close proximity of the radar to contain the 

radar power supply and/or an Ethernet fiber-optic media converter. 

3.1.5 Radar Power Supply

A 28VDC power supply is recommended to power the STS-1400 Radar Assembly. 

NOTE: V3.O Units has been designed to run on as little as a 20 VDC supply.

3.1.6 Network Infrastructure

The network infrastructure consists of Ethernet switches, Ethernet media converters, wireless Ethernet 

transceivers, etc. The network infrastructure provides the physical support for the Device and the Client 

networks. Refer to the installation manual for a description of these networks.

3.1.7 Cabling

ICx Radar Systems provides connectorized cables for sale in standard lengths. Cables can be ordered 

with connectors at each end. Please contact ICx Radar Systems for assistance.

3.2 SOFTWARE COMPONENT DESCRIPTION

The STS-1400 Radar System comprises seven (7) installable software modules.

The seven (7) software modules included in the ICX Radar System Software Package are:

1. Radar Application Manager 

2. Radar Server Application 

3. Radar Terminal Application 

4. Radar Console Application 
Operator Manual – STS-1400

Reference #921-0011-00-MAN-RO6 15



 

5. Radar Loader Application 

6. Control Station Interface 

7. Radar TRaCS (purchased separately)

NOTE: Control Station Interface application is optional and is used only when deploying with other ICx 

radar models such as the (STS-350, STS-350ER, STS-4400 and STS-12000).

NOTE: When multiple radars (any models) are deployed in a single network, the Cameleon Tactical 

application is recommended as the Command & Control application. See your ICx Sales Rep for informa-

tion.

Refer to the installation manual for installation and configuration of these software modules.
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3.2.1 Radar Application Manager 

The Radar Application Manager is a software application that performs the following functions:

• Startup of ICx application software (Radar Server, Radar Terminal, Radar Console and Control 

Station Interface)

• Configuration of ICx application software

• Monitoring of ICx application software

Figure 3 -  Radar Application Manager
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3.2.2 Radar Server Application

The Radar Server is a software application that interfaces with STS-1400 Radar Assemblies and Client 

applications (i.e. Radar Console, Radar Terminal, etc.). The Radar Server principally performs the fol-

lowing functions:

• Generation of targets and intruders;

• Management of targets and intruders;

• Output of detection data to local or remote applications;

• Output of detection data in an XML format to third-party applications;

• Time synchronization of the radar assemblies.

Figure 4 -  Radar Server Application
Operator Manual – STS-1400

Reference #921-0011-00-MAN-RO6 18



 

3.2.3 Radar Console Application

The Radar Console is a software application that interfaces with the Radar Server application, or 

directly with the STS-1400 Radar Assembly, and performs the following functions:

• Displays radar status

• Displays radar contacts and segments

• Displays radar targets and intruders

• Displays and edits radar zones (contact and intrusion zones)

• Displays radar Plan Position Indicator (PPI)

• Displays and configures system parameters

• Displays geographic map as an underlay

• Logs radar assembly warning messages

• Logs radar assembly status
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3.2.4 Radar Terminal Application

The Radar Terminal is a software application that interfaces with the Radar Server. The Radar Terminal 

primarily performs the following functions:

• Keeps the connection between the radar assembly and Radar Server active

• Displays all radar assemblies connected to the Radar Server application

• Displays radar assembly status and radar communication configuration information

3.2.5 Radar Loader Application

The Radar Loader is a software utility designed to load new versions of the STS-1400 Radar Assembly 

firmware. This application is started automatically by the Radar Console application when executing the 

Loader command.

Figure 5 -  Radar Terminal Application
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4 STS-1400 SYSTEM OPERATION

This section covers operation of the STS-1400 Radar System using the Radar Console application. For 

details on how to operate the STS-1400 Radar System using the Control Station application, please refer 

to the Control Station Operator's Manual.

For details on how to perform the installation of the STS-1400 Radar System and installation of the 

required applications, please refer to the STS-1400 Installation Manual.

4.1 RADAR APPLICATION MANAGER

This section covers the operation of the Radar Application Manager. For details on how to configure 

Radar Application Manager to monitor specific applications, please refer to the STS-1400 Installation 

Manual.

Figure 6 shows the Radar Application Manager main window. The description of each element is 

described in the following sections.

Figure 6 -  Radar Application Manager Main Window
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4.1.1 Application Status

The application status will read either ACTIVE, UNLINK or TIMEOUT. An ACTIVE application is monitored 

by the Application Manager and will automatically re-start in the event of a crash, power outage or sys-

tem failure. An UNLINK status reflects an application started manually and that is not monitored by the 

Application Manager. If the application is closed or hangs, the Application Manager will not re-start it. 

When either application with a status of an ACTIVE or UNLINK is closed or hangs, its status changes to 

TIMEOUT.

4.1.2 Application Name

Displays the name (e.g. Radar Console, Radar Server, Radar Terminal, etc.) of each application listed.

4.1.3 Image Name

The image name contains the executable file name of each application.

4.1.4 Application Running Time

The application running time displays the duration that each application has been running. When an 

application is re-started by the Radar Application Manager, the duration is reset to zero. Additionally, 

this value is reset to zero every day at midnight.

4.1.5 Application Parameters

The application parameters field contains the command-line parameters used to start monitored appli-

cations.

4.1.6 Event Log Window

The event log window contains a list of events that occurred since start-up of Radar Application Man-

ager. These events include the (re)starting of applications, timeouts, etc.

4.2 RADAR CONSOLE

The Radar Console allows the configuration of STS-1400 Radar assemblies, the configuration of detection 

and intrusion zones, and the visualization of radar sectors, targets and intruders. 
Operator Manual – STS-1400

Reference #921-0011-00-MAN-RO6 22



 

4.2.1 Operator Login

This application requires the user to login to access most of its functions, as shown in Figure 7. Four (4) 

login levels are supported by Radar Console. This document covers the two (2) first levels (Operator and 

Administrator).

Once logged in, the radar console screen displays available radars in the left pane.

Figure 7 -  Login Operator Mode

Figure 8 -  Radar Console Displaying Available Radars

 

Available 
radars
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Table 5 shows the functions that are accessible as a function of the login level. The Direct column refers 

to functions accessible when the Radar Console is connected directly to the radar, and the Server col-

umn refers to functions accessible when the Radar Console is connected to the radar via the Radar 

Server.

Menu Item Function

Operator  Admin

Radar 
Console 
Direct

Radar 
Console

Radar 
Console 
Direct

Radar 
Console

Edit Edit / create intrusion zones 

Edit / create contact zones 

View View intruders / targets  

View tracks  

View identification number  

View radar PPI    

Change PPI color palette  

View radar location    

Intrusion / contact coverage  

View background map    

View intrusion / contact zones  

View contacts 

Tools Targets / intruders list view  

Targets / intruders tree view  

Replay radar data  

Explore Logs directory    

Explore Maps directory    

Explore Capture directory    

Explore Recording directory    

Table 5 - Radar Console Functions vs. Login Level
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Setup Set Logs directory  

Set Maps directory  

Set Capture directory  

Set Recording directory  

Right mouse click 
on radar icon

Set radar to XMIT / STBY  

Reset radar  

Configure radar parameters    

Show warnings and traces    

Set unit position from GPS  

Set Radar Server time from GPS 

Enable / disable AXML 

Record targets / intruders 

Record radar data  

Reset communication statistics  

Load new radar firmware  

Menu Item Function

Operator  Admin

Radar 
Console 
Direct

Radar 
Console

Radar 
Console 
Direct

Radar 
Console

Table 5 - Radar Console Functions vs. Login Level (Continued)
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4.2.1.1 Radar Symbology 

This section defines the symbology for the radar icon located in the left-hand column of the radar con-

sole. Keep in mind that the colors have a specific meaning as well as the information embedded in the 

icon. Below is an icon lexicon describing the various color codes and symbols.

Figure 9 -  Radar Lexicon

Radar Icon Message

Radar communication link is being established. 

Radar connection is in progress.

Radar is in standby mode.

Radar simulator is in standby mode.

Table 6 - Radar Icons and Messages
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Target Combination Software is stopped.

Radar is in standby mode, and is connected directly to the Radar Con-
sole application (instead of being connected through the Radar Server 

application).

Communication with radar has been interrupted for at least five (5) 
seconds.

Communication with radar is lost. The Operator can still verify the last 
unit configured parameters and most recent unit warnings. The Opera-

tor can manually delete the lost icon. 

Radar is in limited auto-recovery mode, with failure code 5.60. The 
Radar will try to recover from the failure automatically. Refer to the 
error codes section of the Installation Manual for explanatory details.

Radar is in fail mode, with failure code 5.60. Refer to the error codes 
section of the Installation Manual for explanatory details.

Radar is transmitting and initial motor speed accuracy has not yet 
been reached or is temporarily out of limits.

Radar is transmitting.

Target Combination Software is started (with TRaCS only).

Target Combination Software is started and tracking one (1) intruder. 
Icon perimeter is blinking (with TRaCS only).

Radar Icon Message

Table 6 - Radar Icons and Messages (Continued)
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Radar is transmitting and tracking three (3) intruders. Icon perimeter 
is blinking.

Radar is transmitting, tracking one (1) intruder and detecting fourteen 
(14) contacts.

The radar is locked by this console for parameters and zones editing.

The radar is locked by another console for parameters and zones edit-
ing.

The Radar Console is recording data from this radar.

The radar possesses an embedded GPS receiver which cannot have a 
3D position fix. The radar is in standby mode.

The radar possesses an embedded GPS receiver which has a 3D posi-
tion fix. The radar is in standby mode.

The radar possesses an embedded GPS receiver which has a 3D posi-
tion fix. The radar is in transmit mode but there is no synchronization 

with the GPS PPS signal.

The radar possesses an embedded GPS receiver which cannot have a 
3D position fix. The radar is in transmit mode and is synchronized with 

the GPS PPS signal.

The radar possesses an embedded GPS receiver which has a 3D posi-
tion fix. The radar is in transmit mode and is synchronized with the 

GPS PPS signal.

Radar Icon Message

Table 6 - Radar Icons and Messages (Continued)
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When placing the mouse cursor over the radar icon, a radar information box is displayed as follows:

4.2.2 Editing Zones

The STS-1400 Radar System supports two (2) types of zones: Contact and Intrusion Zones.

Radar is busy with another client. 
The radar is accepting only one direct connection. This will be shown 
only on a radar console used in direct mode when the radar server or 

another console (direct) is connected to the radar unit.

Figure 10 -  Radar Information 

Figure 11 -  Radar Information 

Radar Icon Message

Table 6 - Radar Icons and Messages (Continued)
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4.2.2.1 Contact Zones

A Contact Zone is an area where low-level radar detections are processed to identify potential targets. 

An exclusive contact zone is a zone in which processing of low-level radar detections is eliminated. The 

radar uses the contact zones to establish the detection thresholds. ICx Radar Systems recommends the 

use of the default configuration (no contact zone defined).  In this case the entire radar coverage area 

will be used. 

If a particular area is generating false or unwanted targets, such as a highway with automobile traffic, a 

wind turbine, etc., it may be desirable to establish one (1) or more contact zones that do not include 

those areas. Alternatively, you can establish exclusive contact zones covering these areas.

4.2.2.2 Intrusion Zones

An Intrusion Zone is an area where the targets are considered potential threats and classified as intrud-

ers. An exclusive intrusion zone is an area in which classification of targets as intruders is prevented. 

Since intruders trigger alerts (red circle in radar icon – see above) and are sent out through XML, it is 

important to carefully define intrusion zones to minimize nuisance alarms. In order to provide prompt 

detection of intruders, it is very important that all intrusion zones be completely contained in contact 

zones with a sufficient gap (typically > 100m). 

To prevent a particular area from generating false or unwanted intruders, such as a private road within 

the surveillance area, a main entrance in a building, etc. either:

1. Establish intrusion zone so as not to include that area, or

2. Establish an exclusive intrusion zone on that area. 
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Figure 12 -  Contact and Intrusion Zones
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4.2.2.3 Creating A Zone

Using the Edit menu, select the type of zone to create (intrusion, exclusive intrusion, contact or exclu-

sive contact), as shown in Figure 13. The mouse cursor will then change to a diamond () shape.

A zone consists of a polygon made with three (3) or more sides. Each segment is added by left-clicking 

with the mouse at the desired location. Figure 14 through Figure 17 shows a typical zone during the 

edition process. The dashed line shows how the zone will be defined if the user completes the com-

mand.

To start editing the zone, left-click with the mouse at the desired location on the PPI. This will create a 

start control point, and a segment will be shown between this endpoint and the current mouse location. 

Figure 13 -  Edit Menu
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Subsequent left mouse clicks will create additional segments to the zone. While editing the zone, the 

keyboard commands described in Table 7 can also be used.

Figure 14 -  Creating a Zone (Step 1 of 4)
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Figure 15 -  Creating a Zone (Step 2 of 4)
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Figure 16 -  Creating a Zone (Step 3 of 4)
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Figure 17 -  Creating a Zone (Step 4 of 4)
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The user may press the space key to invert the order in which the zone segments are added, as shown in 

Figure 18. The backspace keyboard key removes the last segment added.

To complete the editing process, press the ESC key or left-click with the mouse on the start control 

point. The zone will appear as a solid line polygon for a normal zone and as a dashed line polygon for an 

exclusive zone. Refer to Figure 12 for an example of each zone type.

Figure 18 -  Changing Segment Adding Order
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After editing one (1) or more zones, the changes may be saved or discarded. This is accomplished using 

the appropriate Edit Menu command, Commit Zone Changes as shown in Figure 19, or by using the 

commit button .

4.2.2.4 Modifying an Existing Zone 

To modify an existing zone, the user must enter the zone edition process. This is accomplished using 

the appropriate command in the Edit menu, as shown in Figure 20.

Figure 19 -  Edit Menu Commands

Figure 20 -  Edit Menu Commands
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Once in the zone edition process, each zone will be displayed with its vertex (control) points, as shown 

in Figure 21. While editing the zone, the keyboard commands described in Figure 7 can also be used.

Figure 21 -  Zone Edition Context

 

Intrusion zone Exclusive intrusion zone

Contact zone Exclusive contact zone
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To modify a zone, the user must left-click with the mouse on a vertex of the zone to be modified. The 

zone will then enter the edit mode, as shown in Figure 22 and Figure 23. Once in the edit mode, the 

process is the same as the zone creation process.

Figure 22 -  Modifying a Zone (Step 1 of 2)
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After modifying one (1) or more zones, the changes can be committed (saved) or discarded. This is 

accomplished using the appropriate Edit Menu command, as shown in Figure 22 & Figure 23, or by 

using the commit button .

Figure 23 -  Modifying a Zone (Step 2 of 2)
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4.2.2.5 Deleting a Zone

To delete an existing zone, the user must enter the zone edition process. This is accomplished by select-

ing a Zone Edition command in the Edit Menu (Edit Intrusion Zones, Edit Intrusion Zones (Exclusive), 

Edit Contact Zones or Edit Contact Zones (Exclusive)), as shown in Figure 20.

Once the user is in Edit mode, the user can:

• Delete all intrusion zones using the Edit Menu command

• Delete all contact zones using the Edit Menu command

• Delete all zones using the Edit Menu command

• Delete the zones individually using the mouse cursor

Figure 24 shows the Delete Zone commands from the Edit Menu.

To delete a particular zone using the mouse cursor, left-click on any segment of the desired zone to 

select it and press the Delete keyboard key.

After deleting one or more zones, the changes can be committed (saved) or discarded. This is accom-

plished using the appropriate Edit Menu command, as shown in Figure 24, or by using the commit but-

ton .

Figure 24 -  Edit Menu Commands
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4.2.3 PPI Display

The commands described in the following sub-sections are accessed using the View Menu.

4.2.3.1 Radar PPI (Continuous) 

The PPI displays radar sectors in a continuous mode as they are received. The PPI uses a radial sweep 

pivoting about the center of the display, resulting in a map-like picture of the area covered by the radar 

Figure 25 -  View Menu Commands
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beam. Targets remain visible until the next sweep. Bearing is indicated by the target’s angular position 

in relation to an imaginary line joining the PPI’s origin to the top of the console, as shown in Figure 26.

The PPI position is displayed as a range and bearing relative to the radar position and as latitude and 

longitude coordinates. The bearing angle is given relative to North.

NOTE: When activating the continuous radar PPI, a warning message is displayed concerning band-

width usage. In the case of networks with limited bandwidth, using this mode may result in the PPI not 

Figure 26 -  Cursor Position Indicator
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being updated uniformly. It is recommended to activate only the PPI display when configuring the radar, 

to help in determining background for defining zones.

4.2.3.2 Radar PPI (Snapshot) 

The Radar PPI (snapshot) command displays a screen capture of a specific moment in time. This feature 

is useful to obtain a snapshot of the radar returns in order to use it as a background (map-like picture or 

overlay) for unchanging and known monitored areas. This mode can also be used for troubleshooting. 

Figure 27 -  Radar PPI (Continuous)
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The Radar PPI (snapshot) mode uses very little bandwidth compared to the Radar PPI Continuous 

mode.
 

4.2.3.3 Refresh Radar PPI  

The Refresh Radar PPI command is used in conjunction with the radar PPI (snapshot) mode and is used 

to refresh the map-like picture overlay at desired time intervals. Each time a PPI update is required, the 

operator should select this command.

4.2.3.4 PPI Commands

The PPI commands are described by selecting the Quick Key command of the Help menu.

Figure 28 -  Radar PPI (Snapshot) Mode

Function Action

Pan left Left arrow key

Pan right Right arrow key

Pan up Up arrow key

Pan down Down arrow key

Table 7 - PPI Commands
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Zoom in Page down key

Zoom out Page up key

Zoom all Home key

Zoom Hold right mouse button and move left (zoom in) or 
right (zoom out)

Hold left mouse button, drag mouse and release

Pan CTRL key and hold left mouse button and move, or 
hold left mouse button until cursor changes to a 

hand, then move

Increase PPI intensity + key

Des crease PPI intensity - key

Increase threshold CTRL key and +

Decrease threshold CTRL key and -

Restore intensity and threshold CTRL and home keys

Function Action

Table 7 - PPI Commands (Continued)
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4.2.3.5 Background Map

The Background Map command is used to display a background map to give real world context to the 

location of the zones. Please refer to the Installation Manual for instructions on how to configure a 

background map.

Figure 29 -  Background Map
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4.2.3.6 PPI Color Palette

The PPI Color Palette command is used to display the radar sectors in an alternate set of colors. The PPI 

color intensity is increased by pressing the + (Add) key or decreased by pressing the – (Minus) key.

4.2.3.7 Radar Location

The Radar Location command displays a radar icon at the location of the radar currently selected in the 

left pane of the Radar Console application.

Figure 30 -  PPI Color Palette

Figure 31 -  Radar Location
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4.2.3.8 Range Rings 

The Radar Rings command turns the display of the range rings on or off.

Figure 32 -  Range Rings
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4.2.3.9 Displaying Zones

When not in edit mode, the intrusion and contact zones display can be enabled or disabled using the 

appropriate View Menu command, as shown in Figure 33.

Figure 33 -  View Menu Commands
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Figure 34 and Figure 35 show the display of typical Intrusion and Contact zones.

Figure 34 -  Intrusion Zones (Red Boundary)
Operator Manual – STS-1400

Reference #921-0011-00-MAN-RO6 52



 

The intrusion zone coverage is defined as the area covered by the combined intrusion and exclusive 

intrusion zones. The area in which intruders will be reported is shown in blue. The zone coverage can be 

Figure 35 -  Intrusion Zones (Yellow Boundary)
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enabled or disabled using the appropriate View Menu command, as shown in Figure 25. Figure 36 

shows the intrusion zone coverage for the intrusion zones shown in Figure 34.

The contact zone coverage is defined as the area covered by the combined contact and exclusive con-

tact zones. The area in which the radar will look for targets will be displayed in blue. The zone coverage 

Figure 36 -  Intrusion Zones Coverage
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can be enabled or disabled using the appropriate View Menu command, as shown in Figure 25. 

Figure 37 shows the contact zone coverage for the zones showed in Figure 35.

4.2.4 INTRUDERS AND TARGETS

4.2.4.1 Intruder and Target Symbols

An Intruder is defined as a radar track detected inside an intrusion zone. A Target is defined as a radar 

track detected inside a contact zone. 

The display of intruders and targets is controlled by the View Menu - Intruders and Targets option.

Figure 37 -  Contact Zones Coverage
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Intruders and targets are displayed as shown in Figure 38. The display of the intruder / target identifi-

cation number is controlled by the View Menu - Identification Number option.

When an intruder or target is no longer detected, the point in the icon center disappears (e.g. tar-

get: ). After a few seconds, the symbol changes to . This symbol is then displayed for a configurable 

period of time before disappearing from the PPI. This period is set using the configuration parameters 

"Target_save_tm" and "Intruder_save_tm".

4.2.4.2 Intruder And Target Tracks 

An Intruder or Target Track is the trace of the intruder’s or target's position over a period of time in the 

past. The period during which the track history is recorded is set by the configuration parameter 

"Target_hist_tm" and the distance interval at which the track position is recorded is configured by the 

configuration parameter "target_hist_int" 

The display of tracks is controlled by the View Menu Tracks command.

Hovering the mouse cursor over an intruder or track symbol will display the following information:

• Type (intruder / target)

• Identification number

• Range

• Bearing

• Course

• Speed

• Quality

Figure 38 -  Description of Intruder and Target Symbols
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The information is continuously updated at the bottom of the PPI as shown in Figure 39. It continues to 

be displayed until the target no longer exists.

There are two alternate ways to display intruders and targets information: the List View and the Tree 

View. They are enabled via the Tools menu Targets/Intruders List View (Figure 40) and Targets/Intrud-

ers Tree View (Figure 41) commands.

In the Targets/Intruders List View, left clicking with the mouse on any column will sort the targets and 

intruders based on the selected column. This view is limited to a total of twelve (12) targets and intrud-

ers. If there are more, they won't be listed in this view. For a complete view, use the Targets/Intruders 

Tree View (Figure 41).

Figure 39 -  Selected Intruder / Target Status Line Information

Figure 40 -  Targets/Intruders List View

 
 

Operator Manual – STS-1400

Reference #921-0011-00-MAN-RO6 57



 

The Tree View format is the same as presented at the bottom of the PPI.

4.2.4.3 Contacts 

Radar contacts are low level detections that eventually become targets and intruders. 

Figure 41 -  Targets / Intruders Tree View
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Display of contacts is enabled and disabled using the View Menu Contacts command.

4.2.4.4 AXML Output 

The Amphitech eXtensible Markup Language (AXML) is an output format following the XML standard. 

This output is used to communicate with the ICx Cameleon© Command & Control software, or other 

third-party applications.

4.2.4.5 ICD-0100 Output

The PSR system can output ICD-0100 data. Please refer to the ICD-0100 Operator’s Manual for informa-

tion on configuration and use of the ICD-0100 data link.

Figure 42 -  Radar Contacts
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4.2.5 Recording Data

4.2.5.1 Recording Intruders and Targets Data 

The Recording of Intruders and Targets Data is enabled and disabled by right clicking on the radar icon 

and selecting Record Targets/Intruders Log (Server), as shown in Figure 43. When enabled, a log file is 

created by the Radar Server application.

The Radar Server creates log files with the following format 2009.01.23 Radar #XX Targets Logs.txt, 

where #XX is the radar identification number. Figure 44 shows an example of a targets/intruders log 

file.

Figure 43 -  Record Targets/Intruders Log Command

Figure 44 -  Targets/Intruders Log File Example
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4.2.5.2 Recording Radar Data

The Recording of Radar Data is enabled and disabled by right clicking on the radar icon and selecting 

Record Radar Data (Console: Fixed Duration), as shown in Figure 45.
 

When selecting the command Record Radar Data (Console: Fixed Duration), the user will be prompted 

to enter duration for the recording (from 1 to 60 minutes). The recording of radar data may be required 

during the radar installation phase, in order to allow ICx Radar Systems to assist a customer in estab-

lishing an optimal radar configuration.

Figure 45 -  Record Radar Data Menu

Figure 46 -  Record Radar Data Duration
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4.2.5.3 Radar Control: STBY / XMIT Commands

The radar is set in transmission and standby mode by right clicking with the mouse on the desired radar 

icon, and selecting STBY (standby) or XMIT (transmit). Figure 47 shows the menu used for Standby and 

Transmit commands.

The Reset Radar Unit command is used to reset the radar. This command is accessed the same way as 

Standby and Transmit commands (see Figure 47). During the reset (approximately 30 seconds), the 

radar will not transmit RF energy or detect targets.

The Loader command is used to load new radar firmware. When this command is selected, the user will 

be prompt to select the radar firmware file (see Figure 47).

4.2.6 Radar Operations

4.2.6.1 Set Unit Position from GPS

When a radar unit is equipped with a GPS receiver, it is possible to set its position using the GPS posi-

tion. Radar assemblies version 2.0 or more are equipped with a GPS receiver. Refer to section 3.1.2 to 

determine the radar assembly version. To set the position, right click with the mouse on the radar icon 

and select the Set Unit Position from GPS command.

Figure 47 -  Radar Standby and Transmit Commands
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NOTE: The longer the user waits before setting the GPS position, the better the precision will be on 

the radar position, as the radar continually averages the GPS position an accurate value. ICx Radar Sys-

tems recommends a wait of 24 hours in order to obtain good precision.

4.2.6.2 Reset Communication Statistics 

The radar communication statistics information can be reset by right clicking with the mouse on the 

radar icon and selecting the Reset Communication Statistics command.

4.2.6.3 Log

The Log window shows a list of all warnings and traces associated with a radar. This window is shown 

either by pressing the "w" keyboard key or by right clicking on the radar icon and selecting the Log com-

mand (see Figure 48). Each entry has a date, time and a type ([T] for trace and [W] for warning) associ-

ated with it.

The Radar Console application generates logs files. These files are located in the directory specified by 

the Set Logs Directory (Console) command from the Setup menu, as shown in Figure 49.

Figure 48 -  Logs Window

Figure 49 -  Setup Menu
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There is a log file for each connected radar, and the filename includes the radar’s serial number. 

Figure 50 shows a logs file example. Each entry contains the date, the time, a type ([T] for trace and 

[W] for warning) and a message.

4.2.7 Radar Configuration Parameters

Radar Configuration Parameters control various aspects of the radar operation. There are four (4) 

groups of configuration parameters.

4.2.7.1 Parameters Access 

Depending on the login level, only certain parameters can be modified by the operator, as shown in 

Table 9. In the Function column, the parameter description and parameter name are shown.

Figure 50 -  Logs File Example

Group Description

Base Link Contains the radar identification and communication 
parameters.

Current Contains the set of parameters that are currently 
used.

Default Contains the default set of parameters.

Factory Contains the factory set of parameters.

Table 8 - Configuration Parameters Groups

Menu Item Parameter Name Operator Administrator

Base Link ID  

IP 

Table 9 - Radar Configuration Parameters Access vs. Login Level
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4.2.7.2 Parameters Description 

Param: Radar Setup Sync_method 

Chirp_slot 

Azimuth_offset 

Pos_lt 

Pos_lg 

Elevation 

Height 

Tilt 

TX_sector_1_start_cw
TX_sector_1_stop_cw



TX_sector_2_start_cw
TX_sector_2_stop_cw



Range_index 

Data_link_speed 

GPS_averaging 

Param: Tracker Setup Contact_zone_gap 

Target_hist_tm 

Target_hist_int 

Target_save_tm 

Intruder_save_tm 

Param: Detection Module RD_target_up_az 

Parameter Name Description

ID Radar identification number. Can be any number between 1 and 999

IP Radar IP address. Refer to the installation manual to determine how 
to set this value properly.

Table 10 - Configuration Parameters Description

Menu Item Parameter Name Operator Administrator

Table 9 - Radar Configuration Parameters Access vs. Login Level (Continued)
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Sync_method Synchronization method and chirp slot used. Refer to the Installation 
Manual to determine the appropriate synchronization method and 

time slot.

Synchronization methods are:
0 (none)

1 (manual, chirp slots [0..3])
2 (GPS, chirp slots [0..7])

Chirp_slot

Azimuth_offset Azimuth offset value of the unit. Refer to the installation manual to 
determine the azimuth offset.

Pos_lt Radar location. The radar installation manual describes methods to 
obtain the radar location.

Pos_lg

Elevation

Height Radar installation height above ground.

Tilt Tilt angle value of the antenna. Refer to the installation manual for 
instructions on how to optimize the antenna tilt angle for a given 

environment.

TX_sector_1_start_cw
TX_sector_1_stop_cw

Transmit sectors 1 and 2 start and stop values. Refer to the Installa-
tion Manual to set the number of transmit sectors (1 or 2), and their 

positions.
TX_sector_2_start_cw
TX_sector_2_stop_cw

Range_index Allows to change the radar range between 700, 1400 and 2800 
meters.

Data_link_speed Maximum data link speed between the radar and the Radar Server 
application. This optional parameter can be set to optimize PPI data 

transfer on a slow wireless network.

GPS_averaging If set, and if unit is equipped with a GPS receiver, average the GPS 
position to determine the unit location. This does not affect unit’s 

position but starts GPS position averaging computation. GPS position 
on unit status is display as [AVG] when computation is completed.

Contact_zone_gap When this parameter has a value of -1, detection zones are indepen-
dent of the intrusion zones. 

When this parameter is non zero, the user cannot edit detection 
zones as they are automatically managed by the system. The system 
will automatically create detection zones around the intrusion zones, 

with the size determined by the value of the zone gap parameter.

Target_hist_tm Length of time in the past to keep a track's trajectory. This parame-
ter only affects PPI display and not XML data output.

Parameter Name Description

Table 10 - Configuration Parameters Description (Continued)
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4.2.7.3 Parameter Operations

To access the Radar Configuration Parameters, either right click with the mouse on the radar icon and 

select the Configuration (Parameters) option (see Figure 51), or select the  icon. The parameters 

will appear as follows.

Each parameter can be modified by opening the parameter group, then sub-group (if applicable) and 

typing the new value, as shown in Figure 52.

Target_hist_int Interval at which a track position is recorded. This parameter only 
affects PPI display and not XML data output.

Target_save_tm Length of time during which lost targets are displayed on the PPI.

Intruder_save_tm Length of time during which lost intruders are displayed on the PPI.

RD_target_up_az Radar scan start azimuth angle. Refer to the installation manual to 
determine the optimum update azimuth.

Figure 51 -  Parameters Window

Parameter Name Description

Table 10 - Configuration Parameters Description (Continued)
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NOTE: The parameters from the Base Link group cannot be modified at the same time as parameters 

from other groups. Since they cause a reset, other changes would be lost.

Figure 52 -  Changing Parameters Values 
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Once the new value is entered, the user presses enter. When all the parameter values have been 

changed, the values must be programmed in the unit by pressing the  button, or by right click-

ing on the parameter group and selecting the "Send changes to the unit (FLASH)" command.

Figure 53 -  Programming Unit Parameters
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When right clicking on the Current Parameters group, commands are displayed (as shown in 

Figure 54). These commands allow to:

• Set the current parameters as the default ones

• Set the current parameters to the default values

• Set the current parameters to the factory values

Figure 54 -  Current Parameter Group Commands
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When right clicking on the Default Parameters group, commands are displayed, as shown in Figure 54. 

These commands allow to:

• Restore the default parameters to the factory values.

4.2.7.4 Exporting Radar Parameters

The Export Parameters to Logs Directory command is used to save the configuration parameters of a 

radar after it has been properly configured. If a radar needs to be replaced, this information can be used 

to configure the new unit.

Figure 55 -  Default Parameter Group Commands
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To Export Parameters:

Step 1: In Radar Console log in as Operator or Administrator

Step 2: In Radar Console, select a radar and right click on it. Select Radar Configuration (Figure 56)

Step 3: Select Current (Figure 57)

Step 4: Left click on Current (Figure 58)

Step 5: Select Export parameters to logs directory (Figure 58)

Step 6: Click on Save (Figure 59)

Step 7: Click on Close

Step 8: Repeat steps 2 - 7 for each radar

Figure 56 -  Exporting Radar Parameters (Step 2)
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Figure 57 -  Exporting Radar Parameters (Step 3)

Figure 58 -  Exporting Radar Parameters (Steps 4 & 5)
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NOTE: These parameters are archived with other log files when using the PSRSystem_zip_logs com-

mand from the Tools folder of the ICX Radar Systems start menu.

Figure 59 -  Exporting Radar Parameters (Step 6)
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5 TROUBLESHOOTING

In the event of a radar failure, follow this procedure:

Step 1: Try re-initializing the system

Step 2: If the error persists, gather the following information:

• Physical installation

• Network topology

• Software version

• Radar serial number

• Conditions under which the error occurred

• Any relevant application/system logs

Step 3: Contact Customer Support

Step 4: If you need to leave a message, leave a clear contact name and number as well as date and 

time reporting this support call. ICx will return your call shortly.
Operator Manual – STS-1400

Reference #921-0011-00-MAN-RO6 75


	1 Introduction
	1.1 EQUIPMENT FEATURES

	2 RADAR OVERVIEW
	3 System description
	3.1 HARDWARE COMPONENT DESCRIPTION
	3.1.1 Physical System Overview
	3.1.2 Radar Server Computer
	3.1.3 Radar Client Computer
	3.1.4 Breakout Box
	3.1.5 Radar Power Supply
	3.1.6 Network Infrastructure
	3.1.7 Cabling

	3.2 SOFTWARE COMPONENT DESCRIPTION
	3.2.1 Radar Application Manager
	3.2.2 Radar Server Application
	3.2.3 Radar Console Application
	3.2.4 Radar Terminal Application
	3.2.5 Radar Loader Application


	4 STS-1400 SYSTEM OPERATION
	4.1 RADAR APPLICATION MANAGER
	4.1.1 Application Status
	4.1.2 Application Name
	4.1.3 Image Name
	4.1.4 Application Running Time
	4.1.5 Application Parameters
	4.1.6 Event Log Window

	4.2 RADAR CONSOLE
	4.2.1 Operator Login
	4.2.2 Editing Zones
	4.2.3 PPI Display
	4.2.4 INTRUDERS AND TARGETS
	4.2.5 Recording Data
	4.2.6 Radar Operations
	4.2.7 Radar Configuration Parameters


	5 TroubleShooting

